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Minimum System Requirements

! Microsoft W indows 2000 (with Service Pack 4), W indows XP (with Service Pack 2), W indows

Vista

! 512 MB of free hard drive space

! 512 MB of RAM

! 800 x 600 minimum screen resolution
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Introduction

EzBackup101 provides a simple and secure way to backup and restore the files and folders on your hard

drive. It operates under W indows XP, W indows 2000/2003 and W indows Vista. 

EzBackup101 can be used to backup your files and folders to any internal or external hard drive.  It also

allows you to archive your backup files to removable media, including writable CD-ROM and DVD disks

and other removable media. EzBackup101 currently does not support flash media.

EzBackup101 makes backup very easy because it allows you to schedule backups that will run

automatically. 

Additionally, it offers you the option to backup manually at any time.  If you have an external backup drive

that is equipped with a one-touch activation button, you can initiate a backup by simply pressing the button

on the drive. 

This product manual uses the following conventions: 

ALL CAPS for application-specific terms.

BOLD CAPS for required actions such as “click on NEXT”

Most actions in the software require that you click on the NEXT button to continue. 

NAVIGATION NOTE:

Use the NEXT and BACK arrows to navigate through the program.  If at any time a function seems

unavailable or cannot be activated, use the BACK arrow to navigate to a previous screen or to the

EzBackup101 main screen and try the function again.
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EzBackup101 Quick Start Guide

This Quick Start Guide is designed to allow W indows users to get up and running quickly. However, there

are features of EzBackup101 that are not explained in the Quick Start Guide. For additional information

and more complete explanations, please refer to the complete user manual. 

The Quick Start Guide and product manual use the following conventions: ALL CAPS for application

specific terms, BOLD for required actions.  Use the NEXT and BACK arrows at the upper right of the

screen to complete an action or navigate away from (cancel) an action or a screen.

Use the NEXT and BACK arrows to navigate through the program.  If at any time a function seems

unavailable or cannot be activated, use the BACK arrow to navigate to a previous screen or to the

EzBackup101 main screen and try the function again.

Installing EzBackup101

1. Close any open applications. Insert the EzBackup101 installation disc into your CD-ROM drive. 

W hen the install screen appears, click NEXT to install EzBackup101 on your computer. Ignore

any warnings you may receive from your anti-virus software.

If the install screen does not appear automatically, open My Computer and double-click on the

CD-ROM drive icon to launch the EzBackup101 installer. Alternatively, you can right-click on the

CD-ROM drive icon and select Explore. Find the W indows folder on the CD-ROM drive and open

it. Inside you will find the EzBackup101 folder. Open this folder as well. Then double-click on the

setup.exe file  to start the installation. 

2. EzBackup101 will offer you the opportunity to activate your copy of the software. It is

recommended that you activate EzBackup101 at this time. However, you can activate your copy

of EzBackup101 at any time.

Users who purchase a license online will receive a license code by e-mail, sent to the

e-mail address they used to register with. 

If you have purchased EzBackup101 from a web download, double click on the

downloaded file.  The file will automatically unzip itself and your installation will begin

immediately. 

In the unlikely event that  the installation does not begin automatically, you will need to

manually start the install process. Locate the EzBackup101 folder on your hard drive. 

The EzBackup101 folder was created when you double clicked on the download file and

will be found wherever you saved the original download file (often on your desktop). Open

the EzBackup101 folder and double-click on the EzBackup101 setup.exe file to begin

installation.

You can activate your EzBackup101 software at any time by selecting ACTIVATE

EzBackup101 from the Help menu.
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If you do not wish to activate at this time, select CONTINUE to continue with the trial.  To exit

EzBackup101, select EXIT.

3. If you chose to continue with the trial version, EzBackup101 will ask you to REGISTER your copy

now.  Please complete the brief registration form and click OK to continue. It is important to register

your copy of EzBackup101 so that we may provide you with technical support during your trial period.

Setting Up EzBackup101

After registering your copy of EzBackup101, you will see a prompt asking you if you would like to set

up your SOURCE and DESTINATION DRIVES. Click YES  to continue. EzBackup101 will now search

your computer for available drives.  

 

Two drop-down lists, one labeled SOURCE DRIVE and the other labeled DESTINATION DRIVE, will

appear on screen.  The SOURCE DRIVE is normally your internal drive C:\.  The DESTINATION

DRIVE is the drive you plan to use to store your backup files. For detailed information on archiving

your backups to removable media, please refer to the full EzBackup101 manual section Archive to

CD/DVD... Chapter 8.

Select your SOURCE and DESTINATION DRIVES from the lists and click NEXT.  If either drive is

not listed, check that the drive is properly connected and turned on.

EzBackup101 will not overwrite what is already on your DESTINATION drive.  You may wish to

check the amount of free space on your DESTINATION drive at this time to ensure that there is

If you have neglected to connect or turn on your external drive, do so now.  Then click on the

REFRESH button. This will give EzBackup101 an opportunity to recognize any newly attached

or powered on drives and regenerate the drive lists.  Select your drives and click NEXT to

continue



9     

adequate disk space to store your backup files. 

If, after this initial set up, you need to go back and reconfigure the drives, you may do so by

selecting RECONFIGURE from the main menu or CHOOSE DRIVES from the FILE menu. If the

menu choice you wish is grayed out, click the back arrow located at the upper-right corner of the

screen to return to the EzBackup101 main screen. All menu selections will again be available.

Backing Up Your Files

Select one or more backup icons or click on SELECT INDIVIDUAL FILES at the bottom of the screen

to begin backing up your files.  
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EzBackup101 Full User Guide

Chapter 1:  Installing EzBackup101

Close any open applications.  Insert the EzBackup101 installation disc into your CD-ROM drive.  W hen the

Install screen appears, click NEXT to install EzBackup101 on your computer.

In the unusual event that the install screen does not appear automatically, you can open My Computer and

double-click on your CD-ROM drive icon to launch the installation screen. Or, you can right click on the

CD-ROM drive icon and select Explore. W hen the Explore window appears, find the W indows folder on

the CD-ROM drive and open it. Then find and open the EzBackup101 folder and double-click on the

setup.exe file.

Follow the directions on the screen to continue with the EzBackup101 installation process. W hen the

installation process is complete, click FINISH. The EzBackup101 application will launch automatically.

If you have purchased EzBackup101 from a web download, double click on the

downloaded file.  The file will automatically unzip itself and your installation will begin

immediately. 

In the unlikely event that  the installation does not begin automatically, you will

need to manually start the install process. Locate the EzBackup101 folder on your hard

drive.  The EzBackup101 folder was created when you double clicked on the download

file and will be found wherever you saved the original download file (often on your

desktop). Open the EzBackup101 folder and double-click on the EzBackup101
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Registering Your Copy of EzBackup101

W hen EzBackup101 launches, you will be given the opportunity to activate your copy. It is

recommended that you activate your copy at this time.

If you already have a license code and wish to register the software or if you wish to purchase

a license code now, click ACTIVATE.  

If you wish to exit and shut down the program, click EXIT.

If you prefer to continue using the trial version of the software, click CONTINUE.

If you chose CONTINUE to continue with the trial version, EzBackup101 will ask you to register

your copy of the software. Please complete the brief form and click OK to continue. It is important

to register your EzBackup101 so that we may provide you with technical support during your trial

period.
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W hen you have completed the EzBackup101 activation and/or registration process, a small window

will appear called EzBACKUP SCHEDULE SETUP.  This window provides the option to continue with

the factory default settings, create your own schedule or create no schedule. 

It is recommended that you select the DEFAULT SCHEDULE option at this time.  If you wish to

change this setting later, you may click on the SCHEDULE tab on the main screen to modify your

selection at any time. (See Chapter 6.)

Accept Default Schedule

If you accept the factory set default schedule, EzBackup101 will run a backup of All New and

Modified Files every day at 4:00 P.M.

Create My Own Schedule

If you choose to create your own schedule, you will be taken to the SCHEDULE SCREEN where you

can set up a schedule.  You will be able to select the files you wish to backup and the time(s) you want

backups to take place.

Create No Schedule At This Time

If you choose not to create a schedule at this time, no automatic backups will be carried out. You may

create a backup schedule at a further time simply by clicking on the SCHEDULE tab, or a manual

backup may be performed at any time.  

The Default Schedule is locked and no changes can be made to it. If you would like to set up a

schedule for your backups, you may create new schedules by selecting the option CREATE MY

OW N SCHEDULE. 
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Chapter 2:  Setting Up EzBackup101

Choosing Your Drives

Before you begin to schedule backups, EzBackup101 will require you to verify that the drives it has

automatically selected as your SOURCE and DESTINATION DRIVES are, in fact, the correct drives.  

Two drop-down lists, one labeled SOURCE DRIVE and the other labeled DESTINATION DRIVE, will

appear on screen.  The SOURCE DRIVE is normally your internal drive C:\.  The DESTINATION

DRIVE is the drive you plan to use to store your backup files. For detailed information on archiving

your backups to removable media, please refer to Archive to CD/DVD in Chapter 8.

The DESTINATION drive in the example below is E:\. However your destination drive letter may be

different depending on the number and arrangement of drives on your computer.

If a drive you want to select is not displayed as an option in the appropriate drop-down list, check that

the drive is properly connected and turned on. Also, check in My Computer to see if W indows has

recognized the drive and lists it among your other drives. 

If you have neglected to connect or turn on your external drive, do so now.  Then click on the

REFRESH button. This will give EzBackup101 an opportunity to recognize any newly attached or

powered on drives and regenerate the drive lists.  Select your drives and click NEXT to continue. 
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Reconfiguring Drives

If, after this initial set up, you need to go back and reconfigure the drives, you may do so by selecting

RECONFIGURE from the main menu or CHOOSE DRIVES from the FILE menu. If the menu choice

you wish is grayed out, click the back arrow located at the upper-right corner of the screen to return to

the EzBackup101 main screen. All menu selections will again be available.

Click the  RECONFIGURE menu or CHOOSE DRIVES option from the File Menu, and change your

drives.
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Chapter 3:  Navigating through EzBackup101

All navigation through EzBackup101 is done from the MAIN SCREEN.  There are three function tabs at

the top of the screen:

M Backup
M Restore
M Schedule

Click on one of the three tabs at the top of the screen to select the function you wish to perform.

To Exit EzBackup101

If you wish to exit the EzBackup101 application, select EXIT from the FILE menu.  You cannot exit

EzBackup101 by simply clicking on the X in the right hand corner. EzBackup101 will not close.  It

will simply minimize and remain in your system tray.
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Chapter 4:  Backing Up Files and Folders

Selecting Files and Folders for Backup

EzBackup101 provides two different methods for selecting files for backup.

M Backup by File Type (select entire groups of files by type)

M Select Individual Files Options (select individual files and folders)

Backup by File Type

The easiest way to select files for backup is by file type.  There are five file type icons:

DOCUMENTS 

This includes all document files that have been saved to your hard drive.  EzBackup101

defines documents as those files created by applications such as word processing,

spreadsheet, presentation etc. programs.  Examples of these might be Microsoft W ord, Excel

and PowerPoint documents. All documents ending in the following extensions will be included

in this backup:

 .doc, .docx, .xls, .xlsx, .ppt, .pptx, .xsn, .xsf, .one, .onepgk, .pub, .wpd

EMAIL

This includes all files crated by the Microsoft Outlook email program. Email files created by

any other email program which stores files locally on your hard drive can be backed up using

the SELECT INDIVIDUAL FILES option.

PHOTOS

This includes all photographs and images saved on your hard drive such as those stored in

your “My Pictures” folder and any other folders with images. All images ending in the following

extension will be included in this backup:

 .gif, .jpg, .jpeg, .jpe, .png, .bmp, .tiff, .tif, .iw, .wmf, .emf, .psd, .dng, .tga, .raw, .pcd, .pcx, .pct,

.pict, .emf, .fpx. 

MUSIC

This includes all music files saved on your hard drive such as iT0unes library and My music

folder. All music files ending in the following extension will be included in this backup: 

.mp3, wma, .wax, .wmx, .wpl, m4a, .aac, .cda, cdda, .wav, wave, .mid, midi, rmi, .ra, .rm,

.ram, m4p, .m4b, .mp2, mpa, .aif, aiff, .aifc, av, snd, amr, .qcp, .au, .snd, .amr, .qcp, .nfo.

VIDEO

This includes all video files saved on your hard drive.

 All documents ending in the following extension will be included in this backup 

.mpeg, .mpg, .mpe, .mv1, .mp2, .mpv2, .mp2v, .m2v, .mpa, .m4v, .avi, .wmv, .wvx, .wm,

.wmd, .wmx, .wmz, .mov, .rm, .swf, .qt, .qtm, .qts, .dvr- ms, .asf, .3gp, .3g2, .mp4, .rm.
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Selecting the File Types for Your Backup

To select your files by FILE TYPE, click on the FILE TYPE icon or icons which represent the type of

files you wish to back up.  You may need to scroll to the right to see all of the FILE TYPE  categories. 

To select more than one icon, simply click on one icon then hold down the CTRL key on your keyboard

and click on one or more additional icons. The selected FILE TYPE icon or icons will be highlighted.

Click NEXT to continue.

The BACKUP TYPE Screen will appear and show two options:

M  All Files   

M  New/Modified Files 
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All Files 
EzBackup101 will back up all of the files that match the File Type(s) you have selected. 

Once you tell it what to do, EzBackup101 works automatically in the background and will

not interrupt your work.  However, EzBackup101 can back up only those files that have been

saved to your hard drive.  Some applications, such as certain database programs, work primarily

in memory, saving their data only occasionally to the drive.  To ensure the highest level of data

protection, close as many active applications as you can and make sure that all open files

have been saved to your hard drive before allowing the backup to run.

New/Modified Files 
EzBackup101 will back up only files that match the File Type(s) you have selected which have

been added or changed since your last backup. To ensure the highest level of data protection,

close as many active applications as you can and make sure that all open files have been

saved to your hard drive before allowing the backup to run.

Select the appropriate radio button for the type of backup you prefer and click NEXT  to continue. 

EzBackup101 will ask if you wish to start your backup process.  Click OK to run your backup.
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If you click CANCEL while the backup is in progress a window will appear asking if you would like

to abort backup. Click OK if you wish to stop the backup at this time. Click Cancel if you wish to

continue backing up your files. 

If you decide to abort your back up, EzBackup101 will ask if you wish to delete the aborted

backup. If you click YES, EzBackup101 will delete all files that have been backed up so far on the

destination drive. If you click NO, files that have been backed up so far will be saved. 
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Select Individual Files

If you wish to backup one or more specific files, click on the SELECT INDIVIDUAL FILES link (bottom

right corner of the main screen) without selecting any of the File Type icons. 

The SELECT INDIVIDUAL FILES selection does not work in conjunction with the FILE TYPE icons. 

You may select either SELECT INDIVIDUAL FILES or one or more of the FILE TYPE icons.

The FILE SELECTION AND JOB LIST screen provides an easy way to select individual files and

folders for backup.  It also makes it possible to save these selections so that they may be used again,

eliminating the need to individually select these groups of files and/or folders each time you wish to

perform a backup of these files/folders. Refer to chapter 5: Selecting Files and Using Job Lists.
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Chapter 5: Selecting Files and Using Backup Job Lists

You may select files for one time backup or save JOB LISTS of files that you can use again and again. 

JOB LISTS can be used to simplify and speed up the file selection process for your selected files

backups.

Select the BACKUP tab from the EzBackup101 MAIN SCREEN. Click on SELECT INDIVIDUAL FILES

OPTIONS (bottom right) from the BACKUP SCREEN.  Select SELECTED FILES and click NEXT.

The FILE SELECTION AND JOB LIST screen provides an easy way to select individual files and folders

for backup.  It also makes it possible to save these selections so that they may be used again, eliminating

the need to individually select these groups of files and/or folders each time you wish to perform a backup

of these files/folders. 

The JOB LIST drop down list contains your existing saved JOB LISTS and offers the option to CREATE

NEW  JOB LIST. Each time you select individual files/folders for a backup, EzBackup101 creates a JOB

LIST containing these files/folders and saves it. You can select this JOB LIST and use it again whenever

you wish to backup these particular files/folders. Or, you can delete it and remove it from your JOB LIST

drop down list.  See removal instructions below. 

The main panel displays the contents of your entire SOURCE DRIVE (normally C:\). In addition, there is a

separate list of only those files and folders in your My Documents folder, plus icons indicating the available

FILE TYPES that you can add to a BACKUP JOB LIST.
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Creating a Job List

To navigate to the JOB LIST screen, click on the SELECT INDIVIDUAL FILES option from the

To add items to an existing
BACKUP tab, and click on the radio button next to SELECTED FILES. 

JOB LIST or create a new JOB LIST, under JOB LISTS header, select your choice from the drop

down menu. 

You may choose CREATE NEW  if you are creating a new job list, or if you want to do a one time

backup for certain files. You can also select the name of an existing job list to access a specific job

list. 

Under the JOB LISTS drop down menu, you can select the files that you wish to back up under this

job list. Click on the box in front of the item or items you wish to backup.  For example, click on the

box in front of the VIDEOS icon to select all of your videos for backup.  Or, click on the boxes in front

of both VIDEOS and MUSIC to select all of your video files and all of your music files to your BACKUP

JOB LIST. You cannot select individual files and folders within FILE TYPE categories. To select

individual files and folders, you must use the SOURCE DRIVE or MY DOCUMENTS option.

Click on the box in front of MY DOCUMENTS to select all files within the MY DOCUMENTS folder. 

Click on the box in front of LOCAL DRIVE to select all files (that can be copied) on your SOURCE

drive.  

To select individual files and folders from within either the MY DOCUMENTS folder or the LOCAL

DRIVE, click on the plus (+) sign in front of the item to expand the view of the item’s contents so that

you can see a list of the files and folders within.  Click on the plus (+) sign in front of folders to expose

individual files.  Click on the box in front of any files or folders you wish to backup to select them.  

W hen you select an individual file, you  will see that, not only the file, but all of the folders and

subfolders that contain it are also selected. This provides an easy way to ensure that you are selecting

the correct file. It does not indicate that all of the contents in a folder or folder will be backed up.  If you

wish to backup the entire contents of a folder, simply click the plus sign (+) in front of that folder and

do not select any specific files within the folder. 
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W hen you have finished selecting items for backup, click NEXT to continue.

W hen the “SAVE BACKUP JOB AS window appears. Enter a name for the job list you are creating.  

Click OK. 

EzBackup101 will ask if you would like to start the backup process now. Click YES to start the backup

process or click CANCEL if you wish to cancel the backup.

If you save this job list as Fav. Pictures, for example, the name Fav. Pictures will appear in the drop

down list with all your other saved BACKUP JOB lists.  You can now select this Fav. Pictures list by

name whenever you wish to run a manual backup or schedule an automatic backup which includes

this list of items.  BACKUP JOB LISTS can be viewed, modified, and deleted as often as necessary to

best suit your backup needs. 
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Rename, Delete or Edit a Job List

To rename, delete or edit a an existing JOB LIST, choose the JOB LIST you wish to modify from the

JOB LIST drop down menu.

Rename a Job List

(To navigate to the JOB LIST screen, click on the SELECT INDIVIDUAL FILES OPTIONS from

the BACKUP tab and click on the radio button next to SELECTED FILES.)

Select a job from the JOB LISTS drop down list.  Click on RENAME LIST. A window appears with

your current job list name. Replace this text with the new name you want to give this list. W hen

done click ok. EzBackup101 will ask you if you want to save the list with the new name, click YES

to continue. 

Delete a Job List

(To navigate to the JOB LIST screen, click on the SELECT INDIVIDUAL FILES OPTIONS from

the BACKUP tab and click on the radio button next to SELECTED FILES.)

Select a job from the JOB LISTS drop down list.  The selected files in this JOB LIST will appear in

the main panel. Review the files to make sure this is the list you wish to remove. Click on the

DELETE LIST button. A message will appear asking you to verify that you wish to delete this JOB

LIST.  Click OK if you wish to delete the list.
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Edit a Job List

(To navigate to the JOB LIST screen, click on the SELECT INDIVIDUAL FILES OPTIONS from

the BACKUP tab and click on the radio button next to SELECTED FILES.)

Select a job from the JOB LISTS drop down list. The selected files in this JOB LIST will appear in

the main panel. Click on the EDIT LIST button.  

A list similar to the one you used to create the JOB LIST will appear.  All the files and folders in

the JOB LIST you have selected will have a green box in front them. Find the files and folders you

wish to remove from the list and click the green box in front of these items to deselect them. To

add an  item to the list, click on the box in front of that item to select it. 

Click NEXT to initiate a backup of the items in your edited JOB LIST.  EzBackup101 will run your

backup and automatically save the changes to the JOB LIST. It is necessary to perform a backup

using your edited list in order for the changes you have made to be saved.

It is not necessary to select individual items in the JOB LIST to perform a delete operation.

Simply select the JOB LIST from the drop down list and click DELETE LIST.

It is not possible to add or remove items in a JOB LIST from the JOB LIST main panel.  See

instructions below to make changes.
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Chapter 6: Scheduling File Backups

EzBackup101 provides a variety of backup scheduling options.  It allows you to store up to eight (8) unique

backup schedules. You determine when and how often EzBackup101 will execute your backups by

creating backup schedules. 

Once created, each backup schedule will be automatically executed at the time you have selected for it. 

For example, you may schedule a backup of all new and modified files for every day at 6:00 P.M.  In

addition, you may schedule a backup of selected files at 10:00 A.M., another at 12:00 P.M., another at

2:00 P.M. and another at 4:00 P.M.  In this scenario, your backup list would include five separate backup

schedules, each of which would run automatically at the appointed time.

To know if EzBackup101 is running, look for the EzBackup101 icon in the system tray. This icon will

always appear even if EzBackup101 is running in background mode. If the EzBackup101 icon is visible in

the system tray, then EzBackup101 is running and your scheduled backups will run.

Backup schedules can be modified, disabled, or permanently deleted according to your needs.  

To access the SCHEDULE options, click on the SCHEDULE tab from the main menu.  The SCHEDULE

OPTIONS screen offers three options:  

M  Create New Schedule

M  View or Modify Current Schedule

M  View the Default Schedule

Select an option and click NEXT to continue. 

EzBackup 101 comes with two preset (default) schedules. These schedules cannot be deleted or

modified. If you wish to use a different schedule you must create a New Backup Schedule. 

Default Schedule is set to backup any new files and files which have been modified since the last

backup at 4:00 P.M. every day.

Push Button Backup is set to backup all new and modified files any time the activation button on

the backup drive is pushed.  This only works with backup drives that  have an activation button.

Scheduled backups will only run if EzBackup101 is running. EzBackup101 is set up to

launch automatically when Windows starts up and run in the background. In order to run

your scheduled backups, EzBackup101 must be allowed to launch at startup. 

If you disable EzBackup101 from launching at startup, you must remember to manually

launch the program before your backup is scheduled to take place.
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Create New Backup Schedule

EzBackup101 allows you to create up to eight (8) unique backup schedules.

Click on the SCHEDULE tab.  Select CREATE NEW SCHEDULE.  The BACKUP TYPE screen will

appear. Click the radio button for the type of backup you wish to create from the BACKUP TYPE list.

BACKUP TYPE choices are: ALL FILES, NEW /MODIFIED FILES, and SELECTED FILES.

M  All Files

M  New/Modified Files

M  Selected Files

All Files

Select ALL FILES if you wish to backup all the files (which can be copied) on your hard drive.

New/modified Files

Select NEW /MODIFIED FILES if you wish to backup all the files which have changed or been

added since your last backup.

Selected Files

Select SELECTED FILES if you wish specify exactly which files, folders and/or FILE TYPES

should be backed up.

Click on a radio button to select which type of backup you wish to schedule.  Two additional boxes

will appear: FREQUENCY and START AT.

Frequency List

The FREQUENCY LIST allows you to choose how often you would like your backups to take

place.  Select one of the choices from the FREQUENCY LIST.

If you select DAILY, WEEKLY, MONTHLY or ONE TIME ONLY, you will be required to select a

time from the START AT box at the bottom of the screen. 

If you select WEEKLY, a DAY box will appear listing the days of the week. Click on the radio

button for the day you wish to select. 

If you select MONTHLY, the START AT box will display both a TIME drop down list and a DATE

drop down list.  Select the hour and date you wish your backup to run from these drop down lists.
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Upon Event

Under the FREQUENCY heading, EzBackup101 offers the unique ability to schedule a backup to

happen UPON EVENT.  This feature allows you to select an event which, when it occurs, triggers

an automatic backup.  If your BACKUP DRIVE is not always connected or you are not able to

guarantee that the computer or BACKUP DRIVE will be powered on at a specific time, you may

wish to have a particular event trigger the start of a backup.  You can schedule EzBackup101 to

run a backup whenever one of the following events occur.

USB Connection

EzBackup101 will launch a backup whenever your computer senses that your external USB

BACKUP DRIVE has been connected (or powered on).

Button Pressed

Some external drives feature an auto-launch push button (not the on/off switch.) 

EzBackup101 can be set to launch whenever that auto-launch button is pressed.

System Shutdown

EzBackup101 can be set to run a backup whenever W indows receives a Shut Down

command. (This  will not be triggered by a Restart.)

W hen you have made all of the necessary FREQUENCY selections, click NEXT to save your

SCHEDULE.  Your new SCHEDULE will be assigned the next available number. For example, if you

already have two existing SCHEDULES, EzBackup101 will assign your new SCHEDULE the name

Schedule No. 3. 

Click YES to save the new SCHEDULE.  EzBackup101 will now prompt you to name the SCHEDULE. 

You may enter a descriptive name, such as “Monday Schedule” or “Afternoon Backup” that you will

easily recognize or simply leave the default name of “File Backup” that is already in the box.
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View an Existing Schedule

You can view the details of your scheduled backups, make changes, or delete a schedule completely. 

Click on the SCHEDULE tab, select VIEW OR MODIFY CURRENT SCHEDULE and click NEXT. 

The SCHEDULE LIST screen will appear and display all of your current schedules.

The Schedule List 

Each line in the SCHEDULE LIST represents an existing schedule and indicates the type of

schedule, how often the schedule executes, what days (if applicable) it is set to run, when it

executed last, when it will execute next, and the current status of the schedule.  Each schedule

displayed in the SCHEDULE LIST will automatically execute at its designated time (unless it is

disabled).
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Delete Disable or Enable a Schedule 

Select the line schedule you wish to modify. Right-click on a line to temporarily DISABLE, 

re-ENABLE or permanently DELETE that schedule.  

View or Modify Current Schedule

To view or modify your current schedules, click on the SCHEDULE tab, select  VIEW OR

MODIFY CURRENT  SCHEDULE, and click NEXT.

The Schedule list opens. To modify the setting on a schedule, double-click the schedule or

select it and click NEXT. On the modify window, make  the desired changes to the schedule and

click NEXT. EzBackup will ask if you want to save the changes. Click Yes to save. 
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Modify the Default Schedule

 EzBackup101 includes a FACTORY DEFAULT BACKUP SCHEDULE that is set to backup New

and Modified files every day at 4:00 P.M. EzBackup101 will run the backup every day at 4:00 P.M.

and back up all files that have been added or changed since your last backup.

To view only the DEFAULT BACKUP SCHEDULE, you can click on the SCHEDULE tab, select 

VIEW OR MODIFY DEFAULT SCHEDULE, and click NEXT. 

Modify the Push Button Backup Schedule 

EzBackup101 includes a factory set PUSH BUTTON BACKUP SCHEDULE that is set to backup

New and Modified files anytime you push the activation button on your backup drive.  This function

require that you have an external drive outfitted with an activation button to operate. You can view

the details of the schedule for your Push Button Backup , make changes, or delete it If you do not

have this function on your external drive or do not wish to use this backup option.

To access the Push Button backup Schedule. Click on the SCHEDULE tab, select VIEW OR

MODIFY CURRENT SCHEDULE and click NEXT.  The SCHEDULE LIST screen opens and

displays all of your current schedules.
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Chapter 7: Restoring Files and Folders

EzBackup101 makes it easy to restore files and folders from your backup drive. 

To restore files from your backup drive, click on the RESTORE tab. The RESTORE SCREEN will appear.  

The RESTORE SCREEN contains a RESTORE POINTS drop down list and a list which reflects the

contents of your backup drive.  

Select the restore tab. Then, click on the drop down list to choose a restore point. A restore point contains

the data saved on a specific drive or at a specific time. By choosing a restore point, you can restore a file

or folder to the way it was on a specific date.

To start the restore process, click on the drop down RESTORE POINTS menu, and choose a restore

point. Click on a box in front of an item to select the files and/ or folders you wish to restore from this list. 

You may need to click on the plus sign (+) in front of an item to expand it and reveal its contents so that

you can navigate to the required items.

W hen you have select the files and/or folders you wish to restore, click NEXT to include these items  in

your list of items to be restored. EzBackup101 will ask if you wish to begin to restore the selected files.

Click NEXT to continue.  Click OK when prompted to restore the selected files. Click CANCEL if you wish

to cancel the restore operation.

If you wish to search for all Restore Points for a file, you can do this by clicking on the VIEW  STORE

COPIES OF A FILE option from the Tools menu. Refer to View Store Copies of a File in Chapter 8.
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Overwriting Existing Files

If a copy of the file or folder to be restored already exists on your SOURCE  DRIVE (usually the C:\),

EzBackup101 will ask if you wish to replace that file or folder.  Click YES to replace the existing item,

YES TO ALL to replace all existing items, NO to skip the current item, or NO TO ALL to skip all items

(cancel the restore).
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Chapter 8: Main Menu Items

Preferences 
Certain EzBackup101 functions can be controlled through the PREFERENCES SCREEN. To open

the PREFERENCES SCREEN, select EDIT from the EzBackup101 main menu choices at the top left

of the screen and select PREFERENCES.  The following options are available:

Startup

EzBackup101 is set by default to load when W indows starts up.  If you prefer to launch

EzBackup101 manually, deselect the Load EzBackup at startup option. 

Logging

Backup101 automatically tracks activity whenever EzBackup101 is running. There are three

options to control how much information EzBackup101 can write to the log.  

•    Disable All Logging                                                                                                           

All logging activity will be suspended. 

• Log Files Not Copied                                                                                         

EzBackup101 will maintain a log of only those files that were scheduled to copy but did

not copy

•  Log All Files Copied                                                                                      

EzBackup101 will maintain a log of all the files actually copied in each backup.
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Tools

View Stored Copies of a File

EzBackup101 gives you the option to search for every saved copy of a file. Click on VIEW

STORED COPIES OF A FILE on the tools menu. Select the file you wish to restore and click

NEXT. EzBackup101 will search your backup files and folders and show you all available

restore points which include a copy of that file. 

Consolidate Restore Points

EzBackup101 keeps each backup separated by dates. If you wish to combine all the restore

points into a single one, choose this option from the tools menu, then choose the date range

you wish to consolidate and click NEXT. The most recent version of all files will be moved to

the selected restore point, then the restore points occurring prior to the selected restore point

will be deleted.  
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Archive to CD/DVD

EzBackup101 gives you the option to archive files or restore points to a removable media

such as CD or DVD. To do this, insert a writable CD/DVD into your CD/DVD tray. Select the

ARCHIVE TO DISK option from the Tools menu. 

Select wether want to copy an entire Restore Point or if you want to copy a Folder from your

Source Drive to a CD/DVD.  

Specific Restore Point

To copy a specific restore point to a CD/DVD, click on the radio button next to the

SPECIFIC RESTORE POINT option, Click NEXT to continue. Select from the drop

down list menu the restore point you wish to burn and click NEXT, your archive will

start automatically. 

Folder from the Source Drive

To copy a folder from the Source Drive to a CD/DVD, click on the radio button next

to the FOLDER FROM THE SOURCE DRIVE option. Click NEXT to continue. 

Select the folder you wish to burn and click NEXT. To select individual files and

folders from within either the MY DOCUMENTS folder or the LOCAL DRIVE, click

on the plus (+) sign in front of the item to expand the view of the item’s contents so

that you can see a list of the files and folders within.  Click on the plus (+) sign in

front of folders to expose individual files.  Click on the box in front to select  any

files or folders you wish to archive to the CD/DVD.   

Email Notification 

EzBackup101 can be set to send a confirmation email when a backup has taken place. To do

this, you need to activate the E-MAIL NOTIFICATION option. This notification will let you know

if the scheduled backup was completed successfully or if there were any errors in the

process.
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Select E-MAIL NOTIFICATION from the tools menu. The E-mail notification screen will

appear. 

Fill in all the required information such as the e-mail address you want notifications to be sent

to, the e-mail address to be used as the sender, the mail service (SMTP) host address, and a

subject line. 

If this is your first time setting up the E-mail notification, click on SEND A TEST MESSAGE to

ensure that all the information has been entered correctly and the notification feature is

working properly. Check your e-mail and make sure that you have received the test message.

Notification Settings

There are four options you can choose from for your email notification. EzBackup101 will

send you an email notifying  you the outcome of your backups according to your selection. 

• Notify after every backup 

Choose this option if you want to receive an email every time a backup has been

completed. 

• Notify if a backup fails 

Choose this option if you want to receive emails only when a backup has failed and

was unable to be completed.

• Notify if a backup is skipped

Choose this option if you want to received emails only when a backup was not

performed at the scheduled time. 

• Do not notify 

Choose this option if you do not wish to be notified when EzBackup101 has

completed scheduled backups, or if any of the backups fail. 
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View

View Log File

To view a copy of your current log file, select VIEW LOG from the View menu. 

There are three options to choose from.

Application Log 

This log will show a list of all EzBackup101 activity: if you are running the program in trial

mode, if there were any errors reported, any backups scheduled, processed, completed, or

incomplete. 

Last Backup Log

This log will show the last backup that was scheduled, when and if the backup ran and

whether or not it was successful.

All Backup Log 

This log will show a record of all EzBackup101 activity.  It will include all backups that have

been scheduled, processed, completed or not completed. 

Clear Log Files

To clear the log file of all information, select CLEAR LOG from the View menu. There are two

options to choose from:

Application Log 

This option will delete all EzBackup101 activity logs, including any errors reported, any

backups scheduled, processed, completed or not completed. 

Old Backup Logs (30 days)  

This option will delete logs of all EzBackup101 activity recorded in the past 30 days. 
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Chapter 9: Tips and Guidelines

Do…  perform regular system maintenance to keep your computer in good condition, such as running anti-

virus scans and updating security patches for your OS and applications.

Do…  keep your anti-virus and anti-spy ware software up-to-date.

Do… maintain your hard drive data by backing up regularly. Take advantage of the benefits of the

Scheduled Backup feature.
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Chapter 10: Troubleshooting

W e have tried to make the use of EzBackup101 as uncomplicated and self-explanatory as possible. 

However, if you are experiencing difficulty installing or using EzBackup101, this chapter may provide

useful suggestions for dealing with these issues. 

If the potential issues presented here do not cover the problem you are having, please refer to the How to

Get Help section at the end of this chapter.

Installation

Q:  I inserted the EzBackup101 Installation CD but the installation splash screen does not appear

automatically.

A: Go to My Computer and double-click on your CD-ROM drive (often D:\ or E:\). If the installation screen

still does not appear, right-click on the drive icon and select Explore.  Double-click on the W indows folder

to open it and then on the EzBackup101 folder. Double-click on the setup.exe file to launch the

installation.

  

Drive Information

Q: How do I find out what SOURCE and BACKUP DRIVES have been set up?

A: From the View menu, select CURRENT SOURCE & DESTINATION. Click on BACK to exit this

screen.

Q: What should I do if my backup drive does not appear in the DESTINATION box?

A: First check to make sure the drive is attached and powered on.  If it is not, attach or power it on, then

click REFRESH. This will allow EzBackup101 to regenerate the drive list and your drive should now

appear.  If it does not, open My Computer and check that W indows has assigned the drive a drive letter. 

If not, the drive may need to be formatted before it is usable.  Follow the instructions from your drive

manufacturer or from within W indows to format the drive.

Thumb drives such as ZIP drives will not be recognized by EzBackup101 and you cannot not use

them to store your backup.
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How To Get Help

If you should find that you need help beyond what is offered in this manual, please contact DPS Technical

Support by using the methods below. 

  

Phone: (954) 925-2688

Fax: (954) 925-2889

Email: Support@ezd2d.com

mailto:EzBackupOEMSupport@ezd2d.com
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